DVB-PC TV Stars

User’s Guide
DVB Viewer TEZ

Document Release Date: May 09
Copyright © TechniSat Digital GmbH All Rights Reserved



User’s Guide DVBViewer TE2

CRAPLEr Li INTrOAUCLION ettt essssstsessess s ssssssssasssss s sssssssssssssssssnsssssessssssssssssssssssssssssssessssssnsnssses
USING PIINTEA NEIP oottt ettt sssetssessesssessse e ssetsse s s sss s s tass bbbt s e basesn
USEI'S GUIAE CONVENTIONS coeritrierieeaimeeeinceaisseaeesetases st aasessesse s eas st s s s st s s s st se e sassaesesecs
Chapter 2: Watch TV with DVBViewer TE2
SUIMIMATY ettt st ss sttt bbb e bbbt bR b bbbt bt b s bbb sas
Configure the attached remote control
Configure your keyboard shortcuts or an HID remote control
Configure COM Port IR Receiver / WINLIRC ....c.ccvereneeneesererreeneeecnsenens
Configure the integrated IR Receiver of the SkyStar USB 2..................
DIBVICE SUPPOI T ittt ettt eae sttt ettt st ettt a e ettt s et e e bttt s bt e a e st et e e e see
NO AEVICE ettt s bbb R bR bR b bbb bbb
SINEIE AEVICE ettt ettt bbbttt bbbttt
MUIEIPIE ABVICES ettt ettt s sttt st st s st s ettt bt astssbasbesbsbstans
DVBViewer TE2 - introduction
TN WINAOW oreertrirnieerieentieessecse s s ssseessesasesseessesssesssessse s s s sasesas st sseasse e sas b s ssse bbb ssesaesasess
CONLIOl ANA L00] BTttt sssass s ssss s esss s s sass s s sasesssesssssssses
Watching TV - advanced features
THMIE SPITL oottt s sttt
CRANNETTIST oottt sesesse s e ssssasse b ea e sese s s e s s sasesasens
Favourite list

Teletext
SUDEIEIES ettt sttt
TEIETEXE SUDTITIES ettt es e ese s eas st sas st ass et easeasessssacs
DVB SUDEITIES ettt sttt es et es s aa st sttt bbb
CONfIGUIE the APPIICATION wecureeeeeeeceietieeseiceteeise ettt sssease s ss s bstsse st s bbb s sssesaess
“General” options
Enhanced options
HArAWATE OPTIONS vttt st sssasess s sssssssse st s sssssassssssssssnssssssssssssssssssssssssssssssssssssssssssnsnsas
Renderer options
Decoder options
Chapter 3: Using DVBVIEWET TE2 @S PVR ..cciiireereireeeenreeseeseesetseuseeseeeessessessesetsstssessessessstssessesssssstssessesssssstasessesssens
SUMIMATY ettt ettt ettt st bttt ettt e b bttt sttt e ae s st stacacn

Record Programs MANUAITY .. cceceeeeerreieiieereseseseasesesesensesessessessesessessessesasessessessessessessesssssessesessees
Record programs aUtOMATICAIIY ... ettt b ettt ees
Add events to recorder manually
Play recorded programs with DVBViewer TE2
Play files With DVBVIEWET TE2 ....cvcuueeueererrecueesessessesesssesssesssesseessesssesssssssessessssssnessssssssssesssssssessnessssssssessnes
Play files With third Party SOfTWAIE ...ttt seese et sasessss s sssetanes
Chapter 4: Managing TV/radio ChaNNElS......ceeeecerneemreeneraeereessensseesessesecssessessssssssssessessssssssssesssesssessssssssessns
CRANNEI LISttt sssesssas st sssessssass s s sss b s e sss s bbb a s s saens
EIT MOA@ ettt seserse s s s bbb esse s s sas e bbbt bsetins
Removing and renaming entries from the channel liSt... ..
Scan for new channels
Add new channels using the “Channel SCaN"....... e easesseseessesstasessesssessessesesnn
DVB-S/DVB-S2 (Digital satellite reCEPLION) ..o ccereeceeeremreereeeeeenseeseeeessesseeseeseessessessesseasessesss s sasessessenss
DVB-C (Digital broadband cable reCeption)........c e rieesceseseaessesseessessesssessessessesncs
DVB-T (Digital terrestrial reception)
Chapter 5: IP multicast streaming....c.ccoeeeveeseeeeenne
SUIMIMAIY ettt sttt st s bbbt bbbttt a sttt sbans
Recommended SYStEM FEQUINEMENTS.....ccucceeereesrereiecueesessreeserssesseessessessesssssssesseessesssesssssssssssessesssesssessssasssns
Important information
Streaming of one TV channel trough @ NETWOIK. ...ttt essess et s eseens
Building a network environment for IP streaming
Chapter 6: Keep your DVBViewer TE2 UPAAted .....c.occeecureureeneeeeuneeseeneeeesseeseeeeeessessessesstssessessessstssessessessssssessesseens
How to use the DVBViewer TE2 online update appliCation ......ceeenenenesineineineinesieeseiseseseessesssssessenns




User’s Guide DVBViewer TE2

Chapter 1: Introduction

Using printed help

User’s guide conventions
For clarity, the User’s Guide employs the following conventions:

1. Navigation paths are represented as follows:
“Start” => “Programs” => “DVBViewer TE2” => “DVBViewer TE2”
The path shown in this example launches DVBViewer TE2

2. Pay attention to the following:

This icon designates a note, which is important information about the description above.

This icon designates a warning, which is important information about the description
‘ 2 s above.

3. The DVB-PC TV Stars TV application “DVBViewer TechniSat Edition Version 2” is designated in the
following as “DVBViewer TE2”




User’s Guide DVBViewer TE2

Chapter 2: Watch TV with DVBViewer TE2

Summary

This chapter is divided into three parts. In the first part, the DVBViewer TE2 GUI (graphical user
interface) and the main functionalities are introduced. In the second part, the more advanced
features like the EPG or the PVR are described. The third part shows, how to use the DVBViewer TE2
in combination with your keyboard, mouse or the available TechniSat remote control.

Eutelsat Hotbird 13.0°E, the DVBViewer TE2 is already set up. If you use another satellite
you have to add this to your channel list first before trying to receive a channel. Read
chapter 4 for managing your channel list first.

This chapter requires a correctly configured channel list. If you are using ASTRA 19.2°E or

Configure the attached remote control

For setting configuring your remote please start DVBViewer TE2 and open the “Remote” tab
(DVBViewer TE2 -> Settings -> Remote)

Options

| General I Enhanced | Hardwarel Renderer | Decoder| Remats |

Remote Settings

[T winLirc

S ettings

[ ok || cancel |

Figure 2.01: opening remote control settings tab within DVBViewer TE2

Configure your keyboard shortcuts or an HID remote control

This option is used for configuring your keyboard shortcuts and HID remote controls (like the USB

IR receiver, the 3.5mm jack of the SkyStar HD2/CableStar HD2 and the build in IR receiver of the
SkyStar USB 2 HD Cl and CableStar USB Combo box).

It is always enabled and cannot be unchecked. You can replace the default shortcuts by assigning
functions to your individual keys. Therefore please select “Keyboard” and press the “Settings” button,
which opens the “Input Editor” dialog. For assigning new keyboard shortcuts you have to switch to
the learning mode by pressing the “Learn” button.
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Input Editor [Keyboard)] [3e]
Action Key * | | Settings
Play =
Pause
Recorder...

Channelscan...

StopjLive

TV Guide...

Record

Exit

Options...

Conditional Access Module...

Teletext

Fullscreen -
I ok | [ Cancel ]

Figure 2.02: Remote control settings -> input editor (keyboard)

Now just select the function you intend to assign and press the corresponding key on your keyboard
or remote control.

Input Editor [Keyboard]

Action Key * || Settings
Play =
Recarder...

Channelscan...

StopjLive

TV Guide. ..

Record

Exit

Options...

Conditional Access Madule...

Teletext

Fullscreen - Delete

Learn

| Ok | ’ Cancel

Figure 2.03: Remote control settings -> new shortcut assigned

For deleting a previous assigned shortcut please switch to learning mode and select the entry you
want to remove. By pressing the “Delete” button this assignment will be deleted:

Input Editor [Keyboard]

Action Key * | | Settings
Play =
Recorder...

Channelscan...

Stop/Live

TV Guide...

Record

Exit

Options...
Conditional Access Medule. ..
Teletext

Fullscreen - Delete

| Ok ” Cancel ]

57

Figure 2.04: Remote control settings -> remove a shortcut
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Configure COM Port IR Receiver / WinLIRC

If you want to use the TechniSat COM-Port IR receiver, you have to enable the entry “WinLirc” within
the remote control settings tab:

Options [

| General | Enhanced I Hardware | Renderer | Decoderl Remate |

Remote Settings

[# Keyboard
[ Skystar ISB

S ——

Settings

[ ok || cancel |

Figure 2.05: opening remote control settings tab within DVBViewer TE2

When WinLIRC is started for the first time the “Windows Security Alert” dialog might appear. You
have to allow WinLIRC to open a connection by clicking the button “Unblock”.

ﬂ Windows Security Alert @

@ Windows Firewall has blocked some features of this program

Windows Firewall has blocked this program from accepting incoming network connections. If you
unblock this program, it will be unblocked on all public networks that you connect to. What are the
risks of unblocking a program?

Mame: ts_winlirc

Publisher: Unknown

Path: C:\program files'\dvbviewer te2\ts_winlirc.exe
Metwaork location: Public network

What are network locations?

Keep blocking ‘ @uﬂoﬂ [ I

Figure 2.06: Windows Firewall
Now you have to configure the WinLIRC application

The following error message might appear:
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WinLIRC failed te initialize.
Would you like to change the configuration
and try again?

| OK E | Cancel | h
h

Figure 2.07 WinLIRC Error

If this message appears, the default configuration of WinLIRC does not match the needs of your
system.

Press “OK” to show the configuration tab.
Here you have to configure the COM port (e.g. COM1) where your IR receiver is attached.
You also have to choose the configuration file, which contains the configuration for your remote

control. Press the “Browse” button and choose the file “technisat.cf” (default location: “C:\Program
Files\DVBViewer TE2”) in the appeared “Open” window. Click “Open” to finish the select.

Open =)
Look in:I | DVBViewer TE2 j = &F B
Name Date medif... Type Size
J Language
J Loges
) Shaders

J Transponders

|| technisat.cf

File name: Itechnisat | Cpen I: |

Files of type: IConfigulation Files {~.cfg:”.conf:*.cf:"rc) LI Cancel |

.

Figure 2.08 WinLIRC Configuration

Now your configuration has been completed. Choose “OK” to finish the configuration and start
WinLIRC.

WinLIRC Canfiguration
Part IEDM1 vl Feceiver type— Leam |
" FX device @ DCD device
Speed |1 15200 vI Analyze |
Senze IAutodetect YI Yirtual pulse ISDD Faw Codes |

Usually, speed should be 115200 Sometimes other values are better

[~ animax (enable DTR]
I Mo trayicon. [Main window is available by starting program again) &I
Tranzmitter zettings
’7 [ Inveted [~ hardware camier & DTR T ‘

Config IC:\Proglam Filez\DWBWiewer TE 2\technizat. cf Brawse. .. |

Figure 2.09 WinLIRC Configuration completed

After you configured WinLIRC you have to assign the desired function to the keys on your remote
control. Please select “WinLirc” within the DVBViewer TE2 remote control tab and click on the
“Settings” button for opening the input editor. Within this dialog please click the “Learn” button for
assign remote control keys to the given functions:




User's Guide DVBViewer TE2

Input Editor [WinLirc]
Action Key * | | Settings
Flay =
Pause
Recorder...

Channelscan...

Stop/Live

TV Guide. ..

Record

Exit

Options...

Conditional Access Module. ..

Teletext

Fullscreen -
[ QK ] [ Cancel ]

Figure 2.10: Remote control settings -> input editor [WinLirc]

After you switched to the learning mode just select a function (e.g. record) and press the desired key
on your remote control:

Input Editor [WinLirc]
Action Key * | | Settings
Play
Pause
Recorder...

Channelscan...

StopjLive

TV Guide. ..

Exit

Options...

Conditional Access Module...

Teletext

Fullscreen —
I ok | [ Cancel ]

Figure 2.11: Remote control settings -> new shortcut assigned

For deleting a previous assigned shortcut please switch to learning mode and select the entry you
intend to remove. By pressing the “Delete” button this assignment will be deleted:

Input Editor [WinLirc]
Action Key * || Settings
Flay =
Pause
Recarder...

Channelscan...

StopjLive

TV Guide. ..

Exit

Options...

Conditional Access Medule. ..

Teletext

Fullscreen -
E aK ] ’ Cancel ]

Figure 2.12: Remote control settings -> remove a shortcut
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Configure the integrated IR Receiver of the SkyStar USB 2

If you are using a SkyStar USB 2 please check the entry “SkyStar USB” within the remote control
settings tab:

Options

| General | Enhanced I Hardware | Renderer | Decoderl Remate |

Remote Settings

[# Keyboard

Settings

[ ok || cance |

Figure 2.13: opening remote control settings tab within DVBViewer TE2”

When starting up the SkyStar USB 2 IR control software for the first time the “Windows Security
Alert” dialog might appear. You have to allow WinLIRC to open connection by clicking the button
“Unblock”.

ﬂ Windows Security Alert

@ Windows Firewall has blocked some features of this program

Windows Firewall has blocked this program from accepting incoming network connections. If you
unblock this program, it will be unblocked on all public networks that you connect to. What are the
risks of unblocking a program?

- Mame: ts_winlirc
! Publisher: Unknown
Path: Ci\program files\dvbviewer te2\ts_winlirc.exe
MNetwork location: Public network

What are network locations?

[ Keep blocking ] I [ Unblack: [ i

Figure 2.14: Windows Firewall

On first use of DVBViewer TE2 you have to assign the desired function to the keys on your remote
control. Therefore please select “SkyStar USB” within the DVBViewer TE2 remote control tab and
click on the “Settings” button for opening the input editor. Within this dialog please click the “Learn”
button to assign remote control keys to the given functions:
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H

Input Editor [Skystar USE]

13

Action Key

Py E—

Pause

| Settings: |

Recorder...
Channelscan...
Stop/Live

TV Guide...
Record

Exit

Options...
Conditional Access Module...
Teletext
Fullscreen

q
I.Y

Delste

I oK I[ Cancel ]

Figure 2.15: Remote control settings -> input editor (SkyStar USB)

Now just select the function you intend to assign and press the desired key on your remote control.

Input Editor [Skystar USB] =

»

Action Key

| Settings
Flay

Pause

Channelscan...

StopjLive

TV Guide...

Record

Exit

Options...

Conditional Access Module... Leain
Teletext
Fullscreen

m

Delete

4

I ak ] ’ Cancel

Figure 2.16: Remote control settings -> new shortcut assigned

For deleting a previous assigned shortcut please switch to learning mode and select the entry you
intend to remove. By pressing the “Delete” button this assignment will be deleted:

Input Editor [Skystar USBE] E

»

Action Key

Play

Pause

Channelscan...

Stop/Live

TV Guide...

Record

Exit

Options...

Conditional Access Medule...
Teletext

Fullscreen - Delete *

I oK I[ Catcel ]

| Settings |

Learn

Figure 2.17: Remote control settings -> remove a shortcut

10
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Device support

No device

If no compatible TechniSat DVB device is available during start-up of DVBViewer TE2 the following
error message will appear:

TechniSst] — o

— FilES

0o 0 o0Hoe D000 @

Figure 2.18: Message “No free Device has been found!”

Single device

If you use one single device with DVBViewer TE2 the application will recognize the used device
automatically and present the GUI for the used front-end type (DVB-S / DVB-T / DVB-C).

Multiple devices

If you have installed a multiple number of compatible TechniSat DVB cards / USB devices, DVBViewer
TE2 will automatically recognize the devices installed at the first start-up. You will be able to use your
TechniSat DVB-PC Stars devices within the same session of DVBViewer TE2 (one for watching TV and
one for recording another channel). DVBViewer TE2 can be used as multimedia player for files, which

were recorded with this application

If you scheduled a recording DVBViewer TE2 will start the recording without any further
information to the user. DVBViewer TE2 will use the required device for this operation
automatically.

11



User's Guide DVBViewer TE2

Gotone ==
| General | Enhanced| Hardware | Renderer | Decoder | Hemote|
Hardware Settings
Device: Tunertype:
TechniSat UDST 7000EDA DYE-S Tuner
State:
Mode for low Bandwidth [USE 1.1]
Stop Stream while tuning
Hasz Cl module
|z DVB-52 device
i ok EI Cancel

Figure 2.19: Options menu “Hardware”

If you add or remove one or more TechniSat DVB-PC Stars devices you have to update the device list
manually. For this operation you must start the options menu and open the hardware menu. Here you
have to click onto the “Scan Devices” button for refreshing the device list.

DVBViewer TE2 - introduction

Main window
= » =) n

Files | Channel | View | Settings | Info

ISA ALLOWANCE
ISAs introduced by Gordon Brown |0yrs ago

5 10:40 VE YOUR SAY: bbec.co.ulhaveyoursay = TERMS AN

90 0 6066 ..o 000 @

Figure 2.20: main window during DVB reception

The main window is divided into three areas:
e The first is the menu bar, which contains text-based options to the user.
e The second is the display area. This is the window where TV programs are displayed. The On-
Screen display, EPG info, Channel List and Favourite list will also be displayed in this area.
e The third is the control and tool bar. This area provides access to main functionalities of
DVBViewer TE2 such as EPG, teletext, PVR/time shift, record and the volume control.

12
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Control and tool Bar

@0 0 00006 ....0 000 @

Figure 2.21: control and tool bar during DVB reception

@0 0@ 006006 .0 Q0000

Figure 2.22: control and tool bar during DVB reception in full screen mode

To start the time shift function of DVBViewer TE2 simply press the “Play/Pause” button. If you press
the “Play/Pause” button again, the time shift toggles from paused to playback.

@

If you press the “Stop” button, time shift will stop and DVBViewer TE2 will switch back to live
playback.

Figure 2.23: control bar -> Play/Pause button

&

Figure 2.24: control bar -> Stop button

The “+” and “-” buttons are used to switch channels up and down.

00

Figure 2.25: control bar -> Channel +/- buttons

If you want to switch back to the previous tuned channel you are able to do that via the previous
channel button.

o

Figure 2.26: control bar -> previous channel button

Click onto the channel list button to access the channel list or favourites list

=

Figure 2.27: control bar -> channel list button

If you want to search for new channels please use the channel scan button for opening the channel
scan dialog.

13
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v

Figure 2.28: control bar -> channel scan button

To open a media file (e.g. *.avi, *.mpeg, *.mp3,...) please select the media file button.

=

Figure 2.29: control bar -> media file button

The next buttons will open and close the teletext window and the EPG window (both described in this
manual) and show/hide the mini EPG onscreen display.

S

Figure 2.30: control bar -> teletext button

-

Figure 2.31: control bar -> mini EPG button

o

Figure 2.32: control bar -> EPG button

The record button is used to start and stop manual recordings. The button indicates that a recording
is running, when its inner circle is coloured red.

Figure 2.33: control bar -> record button

You also can schedule records with the recorder dialog, which opens by clicking on the VCR button.

o

Figure 2.34: control bar -> VCR button

The volume during the DVB/file playback can be controlled by the volume slide and muted/unmuted
by the mute button.
Drawn to the left will decrease the volume; drawn to the right will increase the volume.

+¢¢'...l l'l

Figure 2.35: control bar -> volume slider

14
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s

Figure 2.36: control bar -> mute button

The playback slider indicates the position within the program running.

Figure 2.37: control bar -> playback slider
This slider indicates the current position only, if EPG data is sent as part of the TV channel.

A convenient way to open the options dialog is to click the options button located on the toolbar.

&

Figure 2.38: control bar -> options button

Watching TV - advanced features

Time shift

Time shift provides the possibility to pause and resume the running program for short breaks. After
you pause the current program the DVBViewer starts recording the program. After you resume the
playback of the video you can jump forward and backward within the recorded time.

@0 0 6606 ....0 OOG @

Figure 2.39: control bar during DVB reception

The time shift will be started after you have pressed the pause button of the control bar. After the
time shift has started the DVBViewer TE2 records the running program into a DVBViewer TE2 time
shift file, saved to the “\My Documents\My Videos” folder of the “All Users” profile. You can change
this under Options, General.

To resume playback during time shift you have to press the play button in control bar. To hold the
program again you have to press the pause button again.

If you want to leave the time shift mode of DVBViewer TE2 you can do this by switching the channel
you are currently watching or simply press the stop button on the control bar. The time shift will be
cancelled immediately.

one TechniSat DVB card installed the time shift will be cancelled without notice and the
recording will start immediately. It is possible to resume the time shift during the recording
with only one TechniSat DVB card installed if these two channels are located on the same
transponder.

: If a recording is scheduled while you are currently using the time shift function with only

Channel list

If you want to choose a TV or radio channel directly, without clicking through the whole channel list
you might do this using the channel list of DVBViewer TE2. Just move your mouse to the right corner
of the DVBViewer TE2 main window or click the “Channel List” button located in the tool bar.

15
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S - J = ﬁ
% Files | Channel | View | Settings | Info
Search 3
5 Astra TRAHAKRALAM at 1248 -
¥ Hot Bird 5/8/9 at 13.0° 1786 [
5 Astia TEAGA34 at 235°E 17 B
5, Eurobird 1 & Astra 28/28/¢ 1022
a3 v 810
(7 BSkyB 20

4 5% Charnel 4 [eng)
= | Channel 4 (NAR
&% Channel 4 l[,\\)
& Charnel 4
8 Channel 4
% Charnel 4
& Channel 4
> Filmd [eng)
> %58 Filmd +1 (eng)
e Mored +1 [eng) =

4473 channells)

@0 0 0666 ....0 OO @

Figure 2.40: Channel list

/S 10:42 JC BUILDI

The “Channels” tab of the channel list is arranged like a directory tree. Choose your satellite, choose
the type of content (Video or Audio) and select your channel. To choose a channel you have to
double-click onto this channel, DVBViewer TE2 switches directly to the selected one. For information
about editing existing channels or scan for new channels, read chapter 4.

Favourite list

Another way for tuning to a channel more comfortably is to use the built in favourite list of the
DVBViewer TE2. Just move your mouse to the right corner of the DVBViewer main window or click
the “Channel List” button located in the tool bar.

To switch from the channel list to the favourite list you have to click onto the button within the upper
right corner, within channel list.

- | B N
View Settings Info

Search @
W Astra19°E 1065 -
5 Hotbird 13° 2077
By TV 1518

3

B

8 =

A -

Figure 2.41: switch from channel list to favourite list

To switch from the favourite list to the channel list you have to click on the button within the upper
right corner, within the favourite list.

- | O ES

View Settings Info

3259 BBC 1 London

Homes Under the Hammer

Bloombery 3289 Bloomberg

Focus
!EE 3381 EuroNews

Euwiewt Brozlfast Briefing

Figure 2.42: switch from favourite list to channel list

16



User’s Guide DVBViewer TE2

To add a channel to the favourite list you have to click on the channel you want to add with the right
mouse button and select “Add to favourites”.

Techni ~ =0 ES
EWE,'_ Files | Channel | View | Settings | Info

Search 3
[ 8 Cust Chan Active (eng) -
R N EWS

Expand Tree FaRLMNT

Collapse Tree BLBA
TR-0
Hide Filter » TRk
Filter > TV Asia
Group by 3
P Style +1 [eng) |:|
¥ Show Audio/Video Nodes
_D. +1 [eng)
Show channel numbers Gald+1~
Sort by Channel name by [eng)
Sort by Category h+1 eng]
Gardens [eng) =
Info [ ) ]
Editmode [

000 0
Add to Favourites m

Figure 2.43: channel list “Add to Favourites”

The channel will be added to the bottom of the favourite list. You can sort the items of the favourite
list by selecting and moving them within the list.

To open a channel you have to click on the channel twice.

— - . ER % |
| ﬁ SE_“'E . . . . =
Tec : .l'll Files | Channel | View : Settings | Info

FAVOURITES [ ]

BBE 3495 BBC 1 London (eng)

ONE

sz= 3496 BBC 2 England (eng)

Saturday Kitchen

Hotel Trubble

- 4033 BBC NEWS
TEWVS 14
BBC News

@0 0 06666 ..o O06 ©

Figure 2.44: Favourite list

If EPG information is provided by a channel broadcaster in your favourite list the current broadcast
and the progress will be displayed.

To remove a channel from the favourite list you have to select the channel, click on the channel with
the right mouse button and select “Delete”.

17
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i Channel : View | Settings i Info

FAVOURITES

BEE 3495 BBC 1 London (eng)
Saturday Kitchen

mse= 3496 BBC 2 England (eng)

Hotel Trubble

40838 BBC NEWS

To Channellist...
Delete D"

@0 © 06066 ...0 000 @

Figure 2.45: Favourite list “Delete”

The removal of a channel from the favourite list will not have any effect to the channel list.
If you delete a channel from the channel list this channel will also be removed from the
favourite list.

For information about adding channels to the channel list or deleting existing channels from the
channel list read chapter 4.

EPG

The Electronic Program Guide is a service of the DVB technology, which offers additional information
about the running program to end-users. DVBViewer TE2 is capable to receive that kind of
information and offers three methods of presenting that information.

Not all TV stations provides EPG data. This information can only be displayed if the
chosen TV channel provides EPG data.

A Please ensure the current system date and time is set correctly.

EPG onscreen display:

Insert the content into the display area. This option is useful if you want to know which program is
currently running and which program follows.

To display the EPG data into the view area select the MiniEPG Button on the toolbar or press the
TAB-key on your keyboard.

18
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Files | Channel | View | Seftings | Info

BBC NEWS 25.040.09 11:40

4088 |‘E.E;';"

Followed by: 11:45-12:00 E24

@0 0 60606 .0 000 @

Figure 2.46: main window during DVB reception with EPG OSD

SFI - TechniSat SiehFernlInfo

The TechniSat SFl service is an extension to existing EPG services provided by the broadcasters.

Opticns E

General | Enhanced | Hardware I Renderer I Decoderl Fiemotel

Enhanced

Multicast Streaming Settings

Network Interface: | 192.168.1.153 -

[p-Addess: T o 7

The "Multicast Streaming Settings' allow pou to broadcast a by or radio transmission inko your
intranet, in order to receive the same events without installing additional dvb adapters on other
camputers.

SiebFern Info

e | [ Sean

"'SighFern Infa" iz a digital service from TechniSat. |t offers a professionally prepared Al

M,
content for more than 70 T channels. ™

I Ok I ’ Cancel

Figure 2.47: Options menu “SiehFern Info“ download

The SiehFernInfo download dialog is located under: DVBViewer TE2 -> Settings -> Enhanced

You start the download process of the service content by pressing the Scan button. The update
process might take between 30 and 45 minutes. You cannot use DVBViewer TE2 for any other task
while the download of the SFI data is in progress.

The EPG data from SFl service will be merged within the EPG database and can be accessed by using
the EPG Window.
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The TechniSat SiehFern Info service is hosted on the satellite Astra 1G at 19.2° E and can

A be received in Europe only.

This service is limited to German channels only.

EPG window:
For showing the EPG window click the EPG button on the toolbar.

151 er6 (E=5Eol =x3)
Electronic Programming Guide

$I Day  Time Duration  Ewvent Title
Search Do 11:02 01:00 Homes Under the Hammer Martin and Lucy view a ho.
Carigia 1y Do 11:59 00:30 To Buy or Not to Buy A glamorous grandma and...
BBC1CI *
BEC 1E Mids -
BECTEastE] |
i+ BBC 1 East ]

-} BEC 1 London

BC 1 London
BEC 1N West
BECTNE &C
BBCTNI o

4117 channells]
Dietails

Donnerstag, 26.06.2008, 11:53 - 12:29 (00:30)
BEC 1 London

To Buy or Not to Buy

A glamoreus grandma and her friend are taken house-hunting in Halifax by Ed Hall and Kristian Digby. They show her three
potential new homes and give her the chance to try one before she buys. [S]

Audio - BBC ONE - audio, stereo (2 channel)

Audio - BBC ONE Narrative - audic, stereo (2 channel;{

DB Subtitles - BBC ONE - associated EBU Teletext

Teletext - BBC ONE - associated EBU Teletext

ideo - BBC ONE - video, 4:3 aspect ratio, 25 Hz

Figure 2.48: EPG window

Within this EPG window it is possible to change thedisplay of the EPG data to the timeline layout. To
do this open the context menu by clicking the right mouse button and select the entry “Timeline”.
You can also simply push the keys “Ctrl + Tab” simultaneously to change to the timeline view.

Electronic Programming Guide
Station | Day  Time Dwration  Event Title
Search Fr 01:00
[ Music 11 | Fr 01:00 BUSIMESS INTERNATIONAL
- Mews 12 |
Shepping 15 : Timeline Strg+Tab
ravel 3 5
Gamesk.. B Send to PVR Strg+R “
- Swizsddu.. 34
England
- Dapstar Televigio.. -
4117 channel(z]
D etails
Freitag, 11.07.2008, 10:57 - 11:59 (01:00)
CNN Int.
LARRY KING
Send to PYA [ saveEPs | [ ok

SR

Figure 2.49: EPG window -> changing view to timeline
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Electronic Programming Guide

F'11-|]?- 11:['2 11:3? 12:12

ingoo... Joumnallx Im Journal (english}

CHNHN Int. G L NTERMA

<
Details

Freitag. 11.07.2008. 10:57 - 11:53 (01:00)
CHN Int.

LARRY KING

SaveEPG | [ 0K

Send to PYR
—

Figure 2.50: EPG window -> timeline view

Using the EPG window you can gain access to additional information not shown within the EPG
display. It is also possible to save the EPG data to your hard drive as HTML TV magazine. For this
purpose the “Save EPG” button opens the save as dialog.

15 Save As

m'|- Desktop » v|",~||555m‘| }J|

‘ Organize v & Views ~ B New Folder

Favorite Links Size Type » *

Ml Deskiop

il RecentPlaces

m

& Computer
E| Documents

E Pictures
More » tdsdvbtds Public Computer
Folders ~ -
File name:  EPG -
Save as type: | EPG-Data (".htm,*.html} v]
#/ Hide Folders

Figure 2.51: Save as dialog

Enter the location and the name of the files and press the “Save” button. All known EPG data will be
combined into a set of HTML files, which can be displayed with a web browser
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Figure 2.52: Browser with opened DVBViewer TE2 HTML EPG

The second option is the capability of sending programs directly to the DVBViewer TE2 recorder
module. This option is described in chapter 3 “Using DVBViewer TE2 as PVR”

Teletext

Using DVBViewer TE2 you can also gain access to the teletext services of most TV stations. The
teletext is displayed by using the teletext button of the control bar.

T gy ER <
TechniSat . — : ; -0
—T T T— [11€S | Channel @ View Settings i Info

" 100 SKY TEXT 753 25 Apr 1047:31

Y SHu TEHT

= Headlines

Sk Sports

Football Latest

Showbiz News and Gossip
National and Regional Weather

R R
LRy ==

CoORRKE

@0 0 6006 ..o 00 @

Figure 2.53: Teletext display

The use of this application is very simple. Enter the page number using your keyboard or remote
control. You are also able to access sites by clicking on displayed page numbers with the left mouse
button.
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Subtitles

The DVBViewer TE2 supports displaying and recording of teletext and DVB subtitles. By selecting an
entry of the menu “View” => “Subtitles” this option will be enabled.

Teletext subtitles

TechniSat B
— T Te— [ lE5 Channel View Settings Info

On Top

Fullscreen Alt+Enter

Teletext
TV Guide...
Mini EPG

Subtitles
Filter
Shaders
Aspect

©0 0 6666 ..o 000 @

Figure 2.54: Subtitle dialogue for teletext subtitles

The teletext subtitle function requires a channel with teletext and at least one subtitle
page. If the channel does not provide teletext information this option is unavailable.

TechniSst . — -
Fileze | Channel ;| View ! Settings i Info

90 0 6066 ..o 000 @

Figure 2.55: Main window during DVB reception with teletext subtitle
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DVB subtitles
e n

Files | Channel | View | Seftings | Info
OnTop

Fullscreen Alt+Enter

Tec:_ i

Teletext
TV Guide...
Mini EPG

v Mone Subtitles

Filter
Shaders
Aspect

DVB: eng %
Teletext 838

@0 0 60606 .0 000 @

Figure 2.56: Subtitle dialogue for DVB subtitles
Techri : - B Ea
Timl_ Files | Channel | View @ Settings | Info

e
+ ¥

b M i i
at home, two-one to hell. Heaven

Ml

@0 0 6066 ..o 000 @

Figure 2.57: Main window during DVB reception with DVB subtitle

The DVB subtitle function requires a channel with DVB subtitle information. If the channel
does not provide this data the option is unavailable.

Configure the application

Within the DVBViewer TE2 options menu you can configure most of the functionality of the
DVBViewer TE2 to your needs. First the general and enhanced options are introduced:

“General” options
Within the general options you can configure the main settings of DVBViewer TE2.

24



User’s Guide DVBViewer TE2

Options @

General | Erhanced I Hardware I Renderer I Decoder I Hemute|

General Settings

Language: [ English - ]
Location: [London v]
Hide the mouse cursor in fullzcreen mode in secs: 3 :

Prevent Screen saver

Recorders  CG\Users\tdsdvbtds\Videos\, E
Timeshift:  CG\Users\tdsdvbtds\Videos\ E
File Size Control One Click Programming [EPG]
[ split files after Time Before [m) Time after [m)
o ME 0 2 0 -

| ok || Cancel

Figure 2.58: Options “General”

Language:
Using this dropdown box allows you to change the language of the DVBViewer TE2.

Hide the mouse cursor in full screen mode in seconds:
This option configures the timeout when the mouse cursor will be hidden in full screen mode.

Prevent Screen saver:
If a screensaver is activated in your system this option will not allow it to start during the
runtime of the DVBViewer TE2.

Recorder:
For your future records you can specify the location where this file will be saved.

Time shift:
The time shift function of the DVBViewer TE2 will create a temporary file, which may need
massive space on your hard disk drive. With this option you can select a location where this
file is created so you can ensure you choose a disk with plenty of space.

Split files after:
If you intend to burn your records to a CD or DVB this option is a convenient way to split the
files after the desired size during the recording process.

One Click Programming (EPG):
DVBViewer TE2 lets you schedule a recording by selecting an event directly out of the EPG.
Here you can specify the time span when the recording process should be started before and
after your scheduled event.
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Enhanced options

Options ==

General | Enhanced | Hardware I Fienderer I Diecoder I Hemote|

Enhanced

tulticast Streaming Settings

Metwork Interface: [192. 168.1.153 -

Ip-Address: OO cot 772

The "Multicast Streaming Settings™ allow you ta broadcast a b or radio transmizsion inta yaur
intranet, in order to receive the zame events without instaling additional dvb adapters on other
compubers.

SiehFern Info

Fu | Scan
"SiehFern Info" i a digital zervice from TechniSat, |t offers a professionally prepared -'-5:
content for mare than 70 TW channels. -

| ok || Cancel

Figure 2.59: Options “Enhanced”

Network Interface:
Please select here the IP address of the network card you are using for streaming video/audio
data via multicast.

IP-Address:
Enter the multicast IP for streaming video/audio data.

Port:
Here you can change the port you are using for your multcast stream.

SiehFernInfo (Scan):
You start the download process of the service content by pressing the Scan button. The
update process might take between 30 and 45 minutes. You cannot use DVBViewer TE2 for
any other task while the download of the SFI data is in progress.

The EPG data from SFI service will be merged within the EPG database and can be accessed
by using the EPG Window.

The TechniSat SiehFernlInfo service is hosted on the satellite Astra 1G at 19.2° E and can be
received in Europe only.

This service is limited to German channels only.

A
A

26



User’s Guide DVBViewer TE2

Hardware options

Options

Gereral | Enhanced | Hardware | Renderer I Decoder I Hemote|

Hardware Settings

Dewvice: Tunertype;

TechniSat UDST FO00BDA DVE-5 Tuner [ Satellite - ]
State:
[ Mormnal - l

[ t4ade for low Bandwidth [ISE 1.1)
[ Stop Strearmn while tuming

Haz CI module

|z DWEB-57 device

[_ ak, [i] [ Canhcel ]

Figure 2.60: Options “Hardware”

Scan Devices:
DVBViewer TE2 will search for new DVB devices attached to your PC since the last usage of
DVBViewer TE2.

Mode for low Bandwidth (USB 1.1):
If you are using an older USB 1.1 device only capable of lower bit rates this option optimises
the playback especially for those types of devices.

Stop Stream while tuning:
For switching between different channels more fasten please use this option.

Has Cl module:
If your device has an integrated Cl slot/module you can enable this functionality by activating
this option.
The CAM menu dialog itself is located under:
DVBViewer TE2 -> Settings -> Conditional Access Module

Is DVB-S2 device:
To activate the DVB-S2 support within DVBViewer TE2 please enable this checkbox (your
DVB-S must be capable of DVB-S2).

Remote:
To select the IR receiver type press the “Remote” button. The remote control selection dialog

will pop up.
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Renderer options
Options B35S
| General I Enhanced I Hardware | Fenderer | Decoder I Hemote|
Audio/Video Renderer
Preferred Audio Renderer
Auto -
"Default DirectSound Device' iz the most recommended output device. However you may
expenience problems with zurround media files. |0 thiz caze use the "Default W avelut Device"
inztead.
Idze "Default Wavelut Device automatically for multichannel streams
Preferred Video Renderer
lVideo Mizing Renderer 9 -

that flexible on videa farmat changes.

The "Direct Video Renderer” comes with this application and is the most compatible choice as
output device, "Yideo Mixing Renderer ' comes with Direct 3 and supports D, but iz not

| ok || cancel

Figure 2.61: Options “Renderer”

Preferred Audio Renderer:

Select your preferred Audio Renderer.

Preferred Video Renderer:

Select your preferred Video Renderer.

Decoder options

Options

Decoder Settings

MPEG Layer Il

Graup Available

MPEG Layer llI

Vorbis FAILED
Dolby AC3

XwiD FAILED
DivX 3 FAILED
DivX 4 FAILED
DivX 5 FAILED
MPEG 1 ¥ideo

| Generall Enhancedl Hardwalel Hendererl Decoder | Hemnte|

Frefenead

(1] - MainConcept Layer || Audio Deco... =
[0)-AUTO
[0)-AUTO

[[2) - MainConcept Dolby Digital dudio v &
[0]-AUTO
1] - MainConcept Layer 1| Audio Decoder
dainConcept Dolby Digital Audio Dlec

(3] - Microsoft MPEG-1/DD Audia Dec

(0] -&UT0
[0)-&AUTO

[1] - MPEG Video Decoder -

| ok || Cancel

Figure 2.62: Options “Decoder”
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For solving issues between different decoders installed on your system you can use the decoder
settings dialog. Within this configuration panel it is possible to check if a required decoder is installed
or missing. You can also select one specific decoder if more than one decoder is installed on the
system.

Chapter 3: Using DVBViewer TE2 as PVR

Summary

This chapter shows how to use the built in PVR functionality for recording and playback of the
DVBViewer TE2 and also how to play recorded videos with third party software.

Necessary setting:

Before you record files for the first time you should ensure there is enough space available for
recording DVB content.

DVB TV channels could create data rates with up to 25Mbit/s. For this purpose you need
@ more than 10GB of free hard disk capacity for one hour of recording time.

Specify a Volume under “Settings” => “General Settings” => “Recorder” that has enough free disk
space available.

If you are using the FAT32 file system you have to split files caused by the fact that FAT32
can handle files up to 4GB only. In this case you have to check the “Split files” checkbox.

You should also split files if you want to backup the recorded files with CD or DVD recorders. If you
are using NTFS formatted drives and don’t want to save files to CD or DVD there is no need to enable
file splitting (see chapter Configure the application -> General Options).

Record programs manually
To start a manual recording press the record button in the tool bar.

&

Figure 2.28: toolbar -> record button

The recording starts immediately. If you want to stop the recording press the record button again.
The recorded file will be saved in the specified directory.

If you change to another channel during a recording the , All capable DVB Adapters are
busy“ message appears.
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TechniSat ., . — -

Files | Channel | View ! Settings i Info

A record is in progress.
ncel the record to switch to another channel.

9o @ 6666 ..o 66 O

Figure 3.01: "All capable DVB Adapters are busy”

Record programs automatically

The PVR functionality of DVBViewer TE2 provides a recording schedule, which can be programmed
manually or by using the EPG.

Your PC must be active and DVBViewer TE2 must be started for scheduled recording. If
DVBViewer TE2 is not started or the system is not active while passing a scheduled event
time the event entry will be discarded without recording.

If a recording is scheduled while you are time shifting a TV program the time shift will be
cancelled without notice and the recording starts immediately.

Add events to recorder manually

Using the recorder window of DVBViewer TE2 it is possible to add multiple events to the recording
scheduler. You'll find the recorder window by choosing “DVBViewer TE2” => “Record Setting”.

ft’i\i Recorder EI
Videorecorder

Search Channel Day Date Start | End Description
 AtThe Races . 254 8BC1L... | Do | 26.06.20080... | 1%:00 Homes Under the H... | |

£ At The Races

- Audi Channel

- AVAGO (Cable) Tl

- AvaTest u
B4

- B4U Movies

- B4U Music

- Babe Central

-- Babestation

- Babeworld. tv

- Baby Channel

- BabyFirst Date: Start: End:

- BabyTv 26.06.2008 @~ 11:00 | = 12:00
Bangla TV

- BBC 1CI Channel: Description:

. BBC 1E Mids BEC 1London Homes Under the Hammer

- BBC 1East (E)

AT e [ Qe [ @renore |

Figure 3.02: Recorder window
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To add a new event to the scheduler enter the event date, start and end time, the channel number
and the event description. You might take the channel number using the tree view of the channel list
located at the left side of the recorder window. Click “Add” to add the event to the scheduler. If you
want to remove an event choose it and click “Remove”. If you want to edit an existing event choose

this event and edit the necessary values. After this press “Update” and the scheduled event will be
updated.

Add events to recorder using the EPG

For all channels that provide EPG data you might want to use the EPG window to add recording
timers to the recorder timetable:

S oo e
Electronic Programming Guide
Station Dap  Time Duration  Event Title
Seaich Do 11:02 01:00 Homes Under the Hammer Martin and Lucy view a ho...
Lange 1w « | Do 11:58 00:30 To Buy or Not to Buy A glamorous grandma and...
EEC1CI
BEC 1 E Mids |
BEC1East(E] ||
EEC 1 East [w)

= BBC 1 London
BEC 1 London
BEC 1 M 'wWest
BEC1ME &C
BEC 1 NI -

4117 channelis)
Dretails

Donnerstag, 26.06.2008, 11:58 - 12:29 (00:30)
BBC 1 London

To Buy or Not to Buy

A glamorous grandma and her friend are taken house-hunting in Halifax by Ed Hall and Kristian Digby. They show her three
potential new hemes and give her the chance to try ene before she buys. [S]

Audio - BBC ONE - audie, stereo (2 channel)

Audio - BBC OMNE Marrative - audic, stereo (2 channel)

DWE Subtitles - BBC ONE - associated EBU Teletext

Teletext - BBC ONE - associated EBU Teletext

Video - BBC ONE - video, 4:3 aspect ratio, 25 Hz

[Coomerg Coomsrs | [

Figure 3.03: EPG window -> add event to the recorder

To add events using the EPG you have to open the EPG window. Select the event you want to record
and press the “Send to PVR” button.

This event will be added to the recorder scheduler and automatically recorded on your hard drive.

If a recording is scheduled while you are time shifting a TV program the time shift will be
cancelled without notice and the recording starts immediately.
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Play recorded programs with DVBViewer TE2

Play files with DVBViewer TE2

To play recorded files with DVBViewer TE2 open the video using “DVBViewer TE2” => “Files” =>
"Open File...” the “Open” dialogue will appear. Here you can select the multimedia file (i.e. *.ts, *.mpg)
you want to watch using DVBViewer TE.

After DVBViewer TE2 has loaded the file the playback will start immediately.

. ‘_“__‘_'_FE " - @n
TECh_I'Il Files Channel View Settings Info

File: C:\Users\ tdsdvbtds) Videos| 04-25 11-53-39_BBC NEWS E24.ts 25.04.09 11:53

Title: 04-25 11-53-39_BBC NEWS E24
Artist:

Ah.-‘: C:\Users\ tdsdvbtds\ Videos

@0 0 6066 ..o 00O @

Figure 3.04: main window in media file playback mode

There are several ways of returning to TV mode. Choose a channel by using the graphical interface,
your keyboard or a remote control.

Play files with third party software

Almost every media player (e.g. the Windows Media Player) is capable of playback or a file recorded
by DVBViewer TE2.

If you want to play a file recorded using DVBViewer TE2 in a system without this software
@ you have to transcode the file(s) to normal MPEG2 files.
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Chapter 4: Managing TV/radio channels

Channel List

Edit mode

Before you are able to delete, rename, or move channels, categories or whole target roots, you have
to switch to “Edit mode”.

Click with your right mouse button within the channel list. A context menu will open where you have
to activate “Edit mode”.

— e » = = n
—QEHGhnl Files | Channel | View ! Settings | Info
4
clive [eng] -
Expand Tree Active [ara)
Active [ben]
Coll T
olapse fres Active (bul]
Hide Filter 3
) ANT
Filter 2
Group by 3
F
v Show Audic/Video Nodes F B
Show channel numbers
Sert by Channel name +1 (eng)
Sort by Category ferg)
Info
Editmode I}:
To Favourites...

Add te Favourites

i
106 @

Figure 4.01: Channel list -> activated Edit mode

After you have finished editing your channel list deactivate Edit mode again.

Removing and renaming entries from the channel list

To remove an existing element from the channel list you have to select it using the tree view of the
channel list. Click the right mouse button on it and select “Delete” from the context menu.

TechniSat) ==~
-rE_ct!E"_ Files Channel View Settings Info
b AE——— ST UL Lunaun Sy
ey b9 BBC 2England [eng) ‘
- -
v Expand Tree TES 2 |
Collapse Tree 3C Channel [eng]
ebies [eng]
Hide Filter PN
Filter ) Elena)
1 Mids
Group by boET M West
1 rrkstLin
Show Audio/Video Nodes 1 Yorks
Show channel numbers 1 E;:ﬁ;]
Sort by Channel name 5
Sort by Category 2
1'wWales
Info 2 ales
Editmode > 1 Scotland S
Delete lke f'
To Favourites...
Add to Favourites ’ @ 6 @ @

Figure 4.02: Channel list -> delete a channel
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A dialog will pop up to confirm the delete process (press “OK”).

If you want to rename an entry in the channel list select this entry and click on it (like renaming files
and folders in the Microsoft Windows file explorer).

[ - = : - | B ES
mﬁﬂ Files | Channel | View | Settings | Info
S Astia IFAHAKRALAM at 1245
7 HotBird 6/8/9at 13.0°E 1786
S Astra 1EAGAA at 235°F 47
Pl Lrchird 1 & As 2B 1022
=L &10
113 BSkyB 720
\ 112 unknown 5
. [+ 1) BskyB 25
b 153 Radio 212

4473 channel[s]

@0 0 0666 ..o O06 ©

Figure 4.03: Channel list -> rename an entry

Scan for new channels

Add new channels using the “Channel Scan”.
To perform a channel scan you can use the channel scan button within the control bar.

Figure 2.33: Channel scan button in the control bar

DVB-S/DVB-S2 (Digital satellite reception)
This option is used to search for new channels from a satellite reception system.

Scan channels

Target Root Eurohird 1 & Astra 2A/28/ ~  Reception Type |Satelite -
Transponder List | 028.2°E Eurobird 1 & Astra 22 v]

LOF 1 LOF 2 LOF 5W  DiseqC Symbolrates

9750 10600 11700 PosBfOptB ~ | 22000,27500

Freguency (MHz) 10714 [] Free To Air only

End Frequency (MHz) 12740 [ Update

[San Frequency ] k Scan Range J

paT | pMr | soT |

Current Device

Figure 4.04: Channel list -> Scan channels

34



User’s Guide DVBViewer TE2

You must enter the name for the target root and select the satellite you want to scan.

After you have selected the root check the settings required for the LOF and switch frequencies.
DVBViewer TE will use the settings required for universal LNB by default.

If you want to update a channel list you have to enable the option “Update”. Then click the button
“Scan Range” to start the channel scan.

A The scan procedure might take several minutes to complete.

You will find the channels found within the root you specified after the channel scan is completed. If
you used the update function, non-existent channels will be removed and new channels are added to
the specified root.

DVB-C (Digital broadband cable reception)
This option is used to search for new channels from a broadband cable reception system.

Scan channels

Target Root Cableprovider Reception Type

Transponder List [Kabel (QAM &4)

Symbolrates
6900,6111,6875

Freguency (KHz) [T] Free To Air only

End Frequency (KHz) 858000 [Clupdate

[S:Bn Frequency l k Scan Range J

paT | par | sor |

Current Device Signal
| E—

Figure 4.05: Channel list -> Scan channels

You must enter the name for the target root and select the transponder list you want to scan.

If you want to update a channel list you have to enable the option “Update”. Then click the button
“Scan Range” to start the channel scan.

A The scan procedure might take several minutes to complete

You will find the channels found within the root you specified after the channel scan is completed.
If you used the update function channels will be removed which are no longer existing and new
channels where added to the specified root.
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DVB-T (Digital terrestrial reception)
This option is used to search for new channels from a digital terrestrial reception system.

Scan channels

Target Root DVE-T Luxembourg ¥  Reception Type

Transponder List | Terrestrial Betzdorf (Lux.) VI

10600 11700 () Sort by Frequency
@) Sort by Provider

Freguency (KHz) 191500 [] Free To Air only

End Freguency (KHz) 690000 [Cupdate

[Smn Freguency l k Scan Range {i

paT | T | soT |

Current Device Signal
L — ]

Figure 4.06: Channel list “Channel => Scan”
You must enter the name for the target root and select the transponder list you want to scan.

If you want to update a channel list you have to enable the option “Update”. Then click the button
“Scan Range” to start the channel scan.

A The scan procedure might take several minutes to complete

You will find the channels found within the root you specified after the channel scan is completed. If
you used the update function, non-existent channels will be removed and new channels are added to
the specified root.
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Chapter 5: IP multicast streaming

Summary
This chapter will introduce the IP multicast streaming functionality, which is part of the DVBViewer TE2.

Recommended system requirements

e Supported operating systems:
Windows 2000 Professional/Server (service pack 4 required)
Windows XP Home Edition/Professional (service pack 2 required)
Windows XP Professional x64 Edition
Windows Vista (x86, x64)
e Two computer systems, both equipped with fast Ethernet network adapter cards, which are
capable of handling at least 100MBit/s
e Direct connection cable
or
e 100/1000 Mbit/s Ethernet switch or hub

Important information

This HOWTO requires two computer systems, which are configured to operate in a local area network
(LAN) environment. The internal IP network settings should be configured correctly and the wiring
and distribution components should be connected correctly.

To stream a normal TV station you have to ensure that your network is capable of
handling a transfer rate of up to 15MBit/s. If you want to stream HDTV channels you will
need up to 8OMBit/s.

Network streaming works well at a data rate of up to 8MBit/s. If you want to stream
channels, requiring more than 8MBit/s, it should work properly, but this depends on
the quality of the infrastructure components used. Some switches cannot handle higher
bandwidth over a long time period and might break down during operation. The same

is also valid for SoHo broadband routers with integrated switches used for broadband
connections.

You need an MPEG-2 software decoder installed on the streaming client machine to
decode the received DVB content.

WARNING:

If you want to use IP multicast transfers in large-scale environments ensure that the switching
components are capable of handling multicast transfers and the network routers in this
environment are configured to block IP multicast. Otherwise heavy network problems might
occur. Contact your system administrator first, before starting a multicast stream in your
environment.

op b b
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Streaming of one TV channel trough a network

Building a network environment for IP streaming
The common system requirements are listed below:

PC 1:
e One operable DVB-PC TV Stars device
e One configured network interface (100BaseTX or 1000BaseTX)
e 3D AGP/PCle Graphic card with hardware acceleration
e DVBViewer TE2

PC 2:
e One configured network interface (100BaseTX or 1000BaseTX)
e 3D AGP/PCle Graphic card with hardware acceleration
e Astreaming client software installed (e.g.: VideoLAN Client)

In our example we are using two systems:

L ]

Satellife dish

Cross over
SkyStar USB PC 1 network cable PC2
SERVER CLIENT
IP: 192.168.0.1/24 IP: 192.168.0.2/24

Figure 5.01: Multicast test configuration

The multicast server is equipped with a SkyStar USB card and correctly connected to a dish. The
satellite on which the dish is aligned to and the channel, streamed over the LAN, is not important in
this example.

The connection between both systems will be realised with a crossover network cable for direct
connection. It is also possible to use a 100/1000MBit/s network switch or a 100/1000MBit/s Ethernet
hub.
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On our server, we open “Settings” => “Enhanced”.

Options @

General | Enhanced | Hardware I Fienderer I Decoderl Hemote|

Enhanced

Multicazt Streaming Settings

MNetwork Interface: l192. 168.1.153 -

IP-Address: ERERET ot 772

The "Multicast Streaming Settingz" allow you to broadoast a by ar radio fransmizsian inta gaur
intranet, in order to receive the zame eventz without inztaling additional dvb adapters on other
cormputers,

SiehFem Info

L& | | Sean

"SiehFer Infa' iz a digital zervice from TechniSat. It affers a prafessionally prepared v

L
content for mare than 70 TV channels. o

| ok || Concel |

Figure 5.02: Options menu “Enhanced”

Here you have to configure the necessary options for the IP multicast stream.
First you have to choose the IP-address of the network interface. The multicast stream is sent for
distribution. In our example the network interface has the IP 10.0.3.182.

The second piece of information, necessary for IP multicast, is the multicast address and the port the
stream is located on.

If the MC-IP is valid the MC-IP field is filled with green. If the IP is invalid the field is red.

The multicast IP range is specified in RFC 1112 (Aug-01-1989) and the following RFC documents.
Multicast IP addresses are defined to the range between 224.0.0.0 to 239.255.255.255. If you want
to send the stream to all clients in your subnet you have to use the multicast IP 224.0.0.1. For further
information about multicast IP addresses you should read the RFC document.

The multicast port number can be chosen from the range between 0 and 65500. You should not use
the first 1024 ports because they are reserved/used by IP services.

In our example we use the multicast IP 224.0.0.1 for all clients in the local subnet and the port
number 7792.

Press OK to confirm the settings and close the options window.

Now you can start the multicast IP streaming.
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[CE S — : B N
Techni : . . =
= Files ;: Channel : View @ Settings Info
Options..,
Conditicnal Access Module...
Multicastk
Velume

Audio

S RIEE AN
B SR Y

@0 0 0666 ..o 00O @

Figure 5.03: Main window “View” menu with disabled multicast option

To initialise the multicast stream, choose “View” => “Multicast”. Now the current channel will be sent
to the selected network interface.

To receive and view the data stream a streaming client is required. In our example we use the
application “VLC Media Player”. This open source application is available at the project website.

Start the application.

2, VLC media player F=3 EoR(=>x3
File View Settings Audio Video MNavigaticn Help
:ll‘lllﬂﬂ »»||5§ <

x1.00

Figure 5.04: VLC media player

Here you simply click onto “File”...

2 VLC media player [F=(He ()
‘u‘iew Settings  Audioc Video Mavigation Help

Quick Open File... Ctrl-O L

Qpen File... Ctrl-F
Open Directory... Ctrl-E
Open Disc... Ctrl-D
Open Network Stream... Ctrl-N

Open Capture Device.., [} Ctrl-A
Wizard... Ctrl-wW

Exit Ctrl-X

x1.00

Figure 5.05: VLC media player “File” menu
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... and then select the option “Open Network Stream...”.

2 Open.. o
[File [ piss | metwork |DirectShow

® UDPRTP 1234 : Force IPv6

(@ UDP/RTP Multicast Address 224.0.0.1 Port 7792 =

(&) HTTP/HTTPS/FTPMMS
() RTSP risp://

[ Allow timeshifting

Advanced options

[ stream/save [ caching 300

Customize:  udp://@224.0.0.1:7792 -

Figure 5.06: VLC media player “Open...” menu

Then you have to choose “UDP/RTP Multicast” and enter the address and port number where the

multicast IP stream is located.

Then press the “OK” button and VLC Media Player will start the playback of the stream immediately.

:‘2‘. VLC media player EI@

File View Settings Audic Video Mavigation Help

slmm| oo E @ |

0:00:00 /0:00:00  :1.00  udp://@224.0.0.1:7792

Figure 5.07: VLC media player during multicast stream playback
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Chapter 6: Keep your DVBViewer TE2 updated

How to use the DVBViewer TE2 online update application

By using the DVBViewer TE2 online update application you have the ability to get the newest
DVBViewer TE2 versions, transponder lists, etc.

You can start the update application by clicking on “DVBViewer TE2 Online Update” under “Start” =»>
“Programs” => “DVBViewer TE2".

13

'@ Default Programs

"_E Internet Explorer
Windows Calendar
Windows Contacts

¥ Windows Defender

[& windows DVD Maker
&2 Windows Live Messenger Download
[l Windows Mail
 Windows Media Center
Windows Media Player
Windows Meeting Space
ﬁ Windows Movie Maker
Windows Photo Gallery
2] Windows Update

m

. Accessories

. DVBViewer TE2
&l DVBViewer TE2 Online Update
i% DVBViewer TE2 uninstall R
5] DVBViewer TE2

J Extras and Upgrades

. Games

. MainConcept
. Maintenance
J Startup -

4  Back

Start Search 2

Figure 6.01: Shortcut to the DVBViewer TE2 update application

Before starting the updater please ensure that you have an active Internet connection and have
closed any active instance of the DVBViewer. Otherwise the following error message will appear:

Fehler =]

% In order to update quit the DVB Application!

[ ok | [Abbrechen |

Figure 6.02: Error message if DVBViewer is still active

All available downloads are shown within categories. A marked entry indicates a new download and
unchecked entries show you have already downloaded this item before:
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¥ Technisat Update Tool (==
Choose the Updates you want to install

Name Published Fricrity
DvBViewer TE2[1)

DVBViewer TE [+1.0.4.5) 2002 2009 Recommended
Transponderists 4]

[7] DvE-5 06.03.2009 Optional

[T pveC 06.03.2003 Optional

[T ovaT 06.03.2009 Optional

[ ATSC 06.03.2003 Optional
Remate Control Pluging (2]

Skystar 06.03.2009 Optianal

inLinc 06.03.2009 Optional
Language Files (1]

Language File Lpdate 06.03.2003 Optional

Description

I@ Install Cloze

Figure 6.03: New updates are available

If you do not want to download and install an item uncheck it. It will appear as a new available item

the next time you start the update application.

@ Technisat Update Tool (===
Choose the Updates you want to install

MName Published Friority
CMBViewer TE2 (1]

DvBViewer TE [+1.0.4.5) 20.02.2009 Recommended
Transponderists (4]

DVEB-5 0.03.2009 Optional
%VB—C 0E.03.2009 Optional
DvE-T 08.03.2009 Optional
ATSC 0E.02.2009 Optional

Remate Contral Plugins (2]
Skystar 06.03.2009 Optional
WinLic 0E.03.2009 Optional
Language Files [1]
Language File Update 0E.03.2009 Optional
Description

DWVE-5 tiansponderlists

[ @l [ Clese

Figure 6.04: Selecting and deselecting items

After selecting the items to be installed just click on “Install”.
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& Technisat Update Tool [al= ] &=
Choose the Updates you want to install
Mame Published Priority
DVBNiewer TE2 (1)
[T DvEViewer TE [+1.0.45) 20.02.2009 Recommended
Transponderists (4]
DvEe-S 0E.03.2009 Optional
[ DvB-C 08.03.2009 Dptional
] Dve-T 0.03.2009 Optional
@ aT5C 05.03.2009 Optional
Remote Contral Plugins (2]
[ Skpstar 06.03.2009 Dptional
[ winLire 0E.03.2009 Optional
Language Files [1)
[ Language File Update 0E.03.2009 Optional
Description
OWEB-T transponderlists
[ @ dnstal !}] [ Cose |

Figure 6.05: Start the download and installationThe packages selected will be downloaded and installed.

@ Technisat Update Tool [olE==
Choose the Updates you want to install

Name Published FPriority

DVEBViewer TEZ (1)
[T] DVBViewer TE [v1.0.4.5) 20.02.2009 Recommended

Transponderlists [4]
7] oves 0E.02.2003 Optional
O oveC 06.03.2009 Optional
[T oveT 0F.03.2003 Optional
[7] aTsSC 0E.02.2003 Optional

Femate Cantrol Plugins [2)
[7] Skystar 05,02.2009 Optianal
[7] wirLirc: 06.03.2003 Optional

Language Files 1)
[] Language File Update 06.03.2009 Optional

Description
DVB-T transponderlists
Inztallation complete.
'@ Install Close D

Figure 6.06: Download and installation completed

After the installation has been completed you can close the updater application and use the updated
DVBViewer TE2.
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